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NOTICE
Registrations for Value added Course-Data Analytics

February 14, 2020

Applications are invited for the below mentioned Value Added Course offered by AICPA-CIMA:

Course Duration Fee

Data Analytics with R 30 hours ‘ Rs.11,800(including GST)

The registrations for the course are open for all the students of Undergraduate Programme-

B.Com.(Hons.) and B.A. (Hons.) and Postgraduate Programme- M.Com. and G.B.O.

Interested students are required to fill in the registration form latest by Feb 20, 2020 till 5:00 p.m.
Registration form can be accessed using the following link:
https:/forms.gle/fgxBthzArEXwWvXF8

Details regarding course content and schedule of classes are attached herewith.

For any queries related to the course, kindly mail to: valueaddedatsrcc@srcc.du.ac.in

S Madar™™
Convenor (In-charge)

Value Added Courses - oSSl e L

Enclosures:

Annexure I: Detailed Course outline
Annexure II: General Guidelines

Annexure III: Tentative Schedule of classes




Sl. Module Name Topics Duration
No.
1 Introduction to » Introduction to Artificial Intelligence and Data 2 Hours
Data Analytics — Analytics
andR » Factors driving surge in popularity of Data Analytics.
» Data Analytics Use Cases from multiple industries.
» Data Ecosystem of an Organisation.
» Difference between Business Analytics and Data
Analytics
» Skill set for Data Analytics professional.
» Reasons for growing popularity of R.
» Basics of R language
» Introduction to R Ecosystem and Community
» Rin comparison to other analytics tools
2 Installation of R » Installation of R Studio 1 Hour
Studio and > Installation of packagesin R
Packages » Basic operations using R Studio.
3 R programming — » Data types in R — vectors, matrix, arrays, lists, data 2 Hours
Basics | frames.
» Basic Data manipulation
4 R programming — » Use of built in functions in R like, seq(), cbind(), rbind(), 2 Hours
Basics Il merge()
» Summarise and interpreting data using functions like,
str(), class(), length(), nrow(), ncol()
» Inspecting data frames with functions like, head(), tail()
5 R Programming — » For and While Loops in R 2 Hours
Basics Il
6 Data Manipulation » Steps in Data Cleaning 2 Hours
» Data Inspection
» Tackling the issues arising during data cleaning.
» Use of string manipulation functions like grepl(),
grep(), sub()
» Data coercion
» Use of apply() family of functions.
7 Data Importing » Import data from spreadsheets, CSV and text files into 2 Hours
into R R.
» Import data from different file statistical formats like

sas7bdat, spss.

Install packages for database import.

Connect with RDBMS from R and perform basic
functions.




Decision Tree — Classification

SI. | Module Name Topics Learning Outcome
No.
8 Exploratory Data > Exploratory Data Analysis (EDA) — Concepts 2 Hours
Analysis and Data » Performing EDA on datasets
Visualisation » Co-relation function cor() in R
» Use of packages for EDA in R
» Use of Plot function
» Creating various graphs like, boxplot,
density plot and histogram.
9 Visualisation I > Lattice package for Visualisation 3 Hours
> GGplot2 package for visualisation
> Decision making through plots
10 | Data Analysis Project » Steps in Data Analysis Project Management 1 Hour
Management Life Cycle.
11 | Data Mining | > K-means Clustering 3 Hours
» Hierarchical Clustering
12 | Data Mining Il » Association Mining Rule 2 Hours
13 | Data Mining Ill » Linear Regression 3 Hours
> Decision Tree - Regression
14 | Data Mining IV > Logistic Regression 3 Hours
>
>

Random Forest




Annexure Il

10.

11.

General Guidelines-Value Added Courses

Tentative Timelines:

Registration opens: 15 February, 2020

Registration closes: 20 February, 2020

Submission of fee opens: 20 February, 2020

Submission of fee closes: 21 February, 2020

Announcement of Batches: 22 February, 2020

Commencement of Classes: 23 February, 2020

The students are advised to read the guidelines, annexures as well as the embedded
instructions in the registration forms very carefully before proceeding.

The admission for a course will be done on first come first serve basis.

The names of the selected students will be put up in a separate notice. A waiting list will
also be displayed in the same notice. A mail will also be sent from

valueaddedatarcc@srcc.du.ac.in to selected students intimating them of their selection.

The selected candidates will be required to pay fee in full upon confirmation of their
selection.

The fee once paid shall not be refundable or transferable.

On the commencement of the course, it is mandatory for the students to attend all the
classes pertaining to the course.

The total duration of the course shall be 30 hours. The classes will be held on non-
teaching days.

AICPA-CIMA will conduct the exam and also evaluate the same during the course and at
the end of course.

The certificate shall be provided by AICPA-CIMA to the students upon successful
completion of the course.

AICPA-CIMA/ VAC Committee reserves the right to alter, modify or change the content

as it deems fit without assigning any reasons to the students.


mailto:valueaddedatarcc@srcc.du.ac.in
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Total duration: 30 hours

Tentative Schedule of the Sessions

Session Date Time
Session 1 23.02.2020 (Sunday) 9:00 am-12.30 pm
Session 2 29.02.2020 (Saturday) 2:00 pm -5:30 pm
Session 3 01.03.2020 (Sunday) 9:00 am-12:30 pm
Session 4 22.03.2020 (Sunday) 9:00 am-12:30 pm
Session 5 28.03.2020 (Saturday) 2:00 pm -5:30 pm
Session 6 29.03.2020 (Sunday) 9:00 am-12:30 pm
Session 7 02.04.2020 (Thursday) 9:00 am-12:30 pm
Session 8 05.04.2020 (Sunday) 9:00 am-12:30 pm
Session 9 06.04.2020 (Monday) 9:00 am-12:30 pm

Session 10 10.04.2020 (Friday) 9:00 am-12:30 pm
Session 11 11.04.2020 (Saturday) 2:00 pm -5:30 pm
Session 12 12.04.2020 (Sunday) 9:00 am-12:30 pm
Session 13 18.04.2020 (Saturday) 2:00 pm -5:30 pm

* There will be a break of 15-20 minutes in between each of the sessions.




NOTICE

Registrations for Value added Course-Data Analytics

October 6, 2020

Value Added Courses Committee, Shri Ram College of Commerce invites applications for the Value
Added Course-Data Analytics with R offered by AICPA-CIMA.

Details of course are as follows:

Name of the Course Data Analytics with R
Duration 30 Hours
Fee 11,800 (including GST)

The registrations for the course are open for all the students of Undergraduate and Post-Graduate

Courses.
Interested students are required to fill in the registration form latest by Oct 11, 2020 till 5:00 p.m.
Registration form can be accessed using the following link:

https://forms.qgle/8UdVGmjdyJiFx7CTA

Details regarding course content and schedule of classes are attached herewith.

For any queries related to the course, kindly mail to: valueaddedatsrcc@srcc.du.ac.in

Dr. C. S. Sharma
Convenor

Value Added Course Committee

Attachments:

Annexure |;: Detailed Course outline
Annexure I1: General Guidelines

Annexure I11: Tentative Schedule of classes
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Annexure |: Detailed Course outline

Sl. Module Name Topics Duration
No.
1 Introduction to » Introduction to Artificial Intelligence and Data 2 Hours
Data Analytics — Analytics
and R > Factors driving surge in popularity of Data Analytics.
» Data Analytics Use Cases from multiple industries.
» Data Ecosystem of an Organisation.
» Difference between Business Analytics and Data
Analytics
%> Skill set for Data Analytics professional.
» Reasons for growing popularity of R.
> Basics of R language
» Introduction to R Ecosystem and Community
> Rin comparison to other analytics tools
2 Installation of R > Installation of R Studio 1 Hour
Studio and > Installation of packages in R
Packages » Basic operations using R Studio.
3 R programming — » Data types in R — vectors, matrix, arrays, lists, data 2 Hours
Basics | frames.
» Basic Data manipulation
4 R programming — » Use of built in functions in R like, seq(), cbind(), rbind(), 2 Hours
Basics Il merge()
» Summarise and interpreting data using functions like,
str(), class(), length(), nrow(), ncol()
» Inspecting data frames with functions like, head(), tail()
5 R Programming — » For and While Loops in R 2 Hours
Basics Il
6 Data Manipulation » Steps in Data Cleaning 2 Hours
» Data Inspection
» Tackling the issues arising during data cleaning.
» Use of string manipulation functions like grepl(),
grep(), sub()
» Data coercion
» Use of apply() family of functions.
7 Data Importing » Import data from spreadsheets, CSV and text files into 2 Hours
intoR R.
» Import data from different file statistical formats like
sas7bdat, spss.
» Install packages for database import.
» Connect with RDBMS from R and perform basic
functions.




SI. | Module Name Topics Learning Outcome
No.
8 Exploratory Data » Exploratory Data Analysis (EDA) — Concepts 2 Hours
Analysis and Data » Performing EDA on datasets
Visualisation » Co-relation function cor() in R
» Use of packages for EDAinR
» Use of Plot function
» Creating various graphs like, boxplot,
density plot and histogram.
9 Visualisation Il » Lattice package for Visualisation 3 Hours
» GGplot2 package for visualisation
» Decision making through plots
10 | Data Analysis Project » Steps in Data Analysis Project Management 1 Hour
Management Life Cycle.
11 [ Data Mining | » K-means Clustering 3 Hours
» Hierarchical Clustering
12 | Data Mining Il » Association Mining Rule 2 Hours
13 [ Data Mining Ill » Linear Regression 3 Hours
» Decision Tree - Regression
14 | Data Mining IV » Logistic Regression 3 Hours
» Decision Tree — Classification
» Random Forest
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10.

11.

General Guidelines-Value Added Courses

Tentative Timelines:

Registration opens: 7 October, 2020

Registration closes: 11 October, 2020

Submission of fee opens: 12 October, 2020

Submission of fee closes: 16 October, 2020

Announcement of Batches: 17 October, 2020

Commencement of Classes: 18 October, 2020

The students are advised to read the guidelines, annexures as well as the embedded
instructions in the registration forms very carefully before proceeding.

The admission for a course will be done on first come first serve basis.

The names of the selected students will be put up in a separate notice. A waiting list
will also be displayed in the same notice. A mail will also be sent from

valueaddedatarcc@srcc.du.ac.in to selected students intimating them of their

selection.

The selected candidates will be required to pay fee in full upon confirmation of their
selection.

The fee once paid shall not be refundable or transferable.

On the commencement of the course, it is mandatory for the students to attend all the
classes pertaining to the course.

The total duration of the course shall be 30 hours. The classes will be held on non-
teaching days.

AICPA-CIMA will conduct the exam and also evaluate the same during the course
and at the end of course.

The certificate shall be provided by AICPA-CIMA to the students upon successful
completion of the course.

AICPA-CIMA/ VAC Committee reserves the right to alter, modify or change the

content as it deems fit without assigning any reasons to the students.
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Tentative Schedule of the Sessions

Total duration: 30 hours

Session Date Time
Session 1 18.10.2020 (Sunday) 9:00 am-12.30 pm
Session 2 25.10.2020 (Sunday) 2:00 pm -5:30 pm
Session 3 30.10.2020 (Friday) 9:00 am-12:30 pm

Holiday-1d-e-Milad
Session 4 01.11.2020 (Sunday) 9:00 am-12:30 pm
Session 5 08.11.2020 (Sunday) 2:00 pm -5:30 pm
Session 6 15.11.2020 (Sunday) 9:00 am-12:30 pm
Session 7 22.11.2020 (Sunday) 9:00 am-12:30 pm
Session 8 28.11.2020(Saturday) 9:00 am-12:30 pm
Session 9 29.11.2020 (Sunday) 9:00 am-12:30 pm
Session 10 30.11.2020 (Monday) 9:00 am-12:30 pm
Holiday-Guru Nanak’s Birthday

* There will be a break of 15-20 minutes in between each of the sessions.

*The mode of classes will be Online/Offline depending upon the prevalent situation.



NOTICE

Registration to Value added Course

September 27, 2019

Applications are invited for the following values added courses for undergraduate and postgraduate

programmes:
Course Duration Fee
Data Analytics Certificate Series | 30 hours Rs.11,800(including
GST)
Artificial Intelligence 30 hours Rs.11,800(including

GST)

Module on Assurance and Audit | 30 hours

. 3,000 plus GST

The courses are open for registration for all the students of undergraduate programme -

B.Com.(Honours) and B.A. (Honours) and Postgraduate programme -M.Com. and G.B.O..

Interested students are requested to fill in the registration form latest by 28 September, 2019 till 11:59

p.m.
Form for Registration can be opened using the following link:
https://forms.gle/X 1 NE4cU7‘g82guVX87

For queries relating to value added courses, kindly mail*to:

valueaddedatsrcc@srcc.du.ac.in

\ e

In-Charge, Value Added Courses

Enclosures:

Annexure I: General Guidelines

. Annexure II: Detailed Course outline

Annexure III: Tentative Schedule of classes

W0 Vo
f.Simrit Kaur

Principal

11



Annexure I

10.

11.

12.

General Guidelines-Value Added Courses

. Tentative Timelines:

Registration opens: 27 September, 2019

Registration closes: 28 September, 2019

Submission of fee opens: 29 September, 2019

Submission of fee closes: 30 September, 2019

Announcement of Batches: 1 October, 2019

Commencement of Classes: 2 October, 2019

The students are advised to read the guidelines, annexures as well as the embedded
instructions in the registration forms very carefully before proceeding.

A student can enrol for only one-value added course at a time.

The admission for a course will be done on first come first serve basis.

The names of the selected students will be put up in a separate notice. A waiting list
will also be displayed in the same notice. A mail will also be sent from

valueaddedatarcc@srcc.du.ac.in to selected students intimating them of their

selection.

The selected candidates will be required to pay fee in full upon confirmation of their
selection.

The fee once paid shall not ne refundable or transferable.

On the commencement of the course, it is mandatory for the students to attend all the
classes pertaining to the course.

The total duration of the course shall be 30 hours. The classes will be held on non-
teaching

days.

AICPA-CIMA / Thinking Bridge will conduct the exam and also evaluate the same
during the course and at the end of course.

The certificate shall be provided by AICPA-CIMA/ Thinking Bridge to the students
upon successful completion of the course.

AICPA-CIMA/Thinking Bridge/ SRCC reserves the right to alter, modify or change

the content as it deems fit without assigning any reasons to the students.

12



Annexure II

Course Outline: Data Analytics

Sessions

Topics

Session 1

Determine how the digital transformation and disruption
landscape create opportunities across the enterprise

Identify the organizational ecosystem needed for becoming a
data-driven organization.

Session 2

Analyze the life cycle of data and its implications for data-
driven decision making

Compare common problems and risks associated with becoming
a data-driven business

Session 3

Differentiate on data analysis tools.

Identify requirements for data-driven projects

Session 4

Distinguish how to develop a customer journey map
Application of Data Analysis Essentials

Determine and classify variables

Session 5

' Calculate central tendency -

Calculate measurement and variability.

Session 6

Calculate basic probability.
Calculate conditional probability

Calculate advanced probabilities

Session 7

Caleulate discrete distributions

Calculate continuous distributions

Session 8

| Analyze statistics in R case study

Analyze distributions in R case study.

13



Course Outline: Artificial Intelligence

Session TOPIC
Session 1 Introduction: what is and what is not Al
History of Al
Turing test, Concept of satisficing & “good enough” decisions
Session 2 Problem solving agents, introduction to Al problems
Introduction to machine learning
supervised and unsupervised learning
Session 3 Applications of Al:
Economics, e-Commerce, Customer support, Financial risk
Al for Good
Session 4 Applications of Al:
Social Media, Web Search, Video Streaming, Email
classification
Session 5 Reserved for a topic picked by students
Session 6 Applications of Al:
Healthcare, Agriculture, Education, Security and surveillance
Al solution design group exercise
Session 7 Basic introduction to AI model building
Modelling an Al system:
hands on exercise Part |
Session 8 Modelling an Al system:
hands on exercise Part 2
Course assessment

14



Course Outline: Module on Assurance and Audit

# Sessions | " ¢

Topics

Course Introduction & Materiality Testing

Basic Excel Training

Advanced Excel & Audit Tools

Cash & Bank and Financial Investments- Walkthrough, Testing,
Workpaper Formation

Operating Expenses and Creditors

Revenue: Confirmations + Debtors

Fixed Assets, Closing stock - Floor to Sheet, Sheet to Floor, Share
Capital testing

Payroll testing, Actuarial testing

Borrowings, Prepaid Exp. & Impairment Testing

Provisions, Cap Commitments, Statutory Dues, Off Balance Sheet
Items, Secretarial Audit, JV Testing

Checking for
Divergences

Variance & Ratio
Analysis

" Reporting, CARO, Internal Financial

Controls

Conclusion, Course Highlights & Key Pointers

15



Annexure III

Tentative Schedule of the Sessions

Total duration: 30 hours

Session Date Time
Session 1 02 October, 2019 (Wednesday) 9:00 am-1:15 pm
Session 2 13 October 2019 (Sunday) 9:00 am-1:15 pm
Session 3 19 October 2019 (Saturday) 1:45 pm -6:00 pm
Session 4 20 October 2019 (Sun(.iay) 9:00 am-1:15 pm
Session 5 26 October 2019 (Saturday) 1:45 pm -6:00 pm
Session 6 03 November 2019 (Sunday) 9:00 am-1:15 pm
Session 7 | 10 November 2019 (Sunday) 9:00 am-1:15 pm
Session 8 12 November 2019 (Tuesday) 9:00 am-1:15 pm

* There will be a break of 15 minutes in between each of the sessions.




Ermst & Young Associates LLP Phone: (+91-124) - 457 5000
1st Floor, Tower A, Building No.8, Fax: (+91-124) - 457 5200
DLF Cyber City, Phase Il, Sector-25,

Gurgaon - 122002, India.

mrit Kaur, Principal
IRAM COLLEGE OF COMMERCE

Jfaurice Nagar,
Norh Delhi
/ Delhi, DL 110007

Dear Dr. Simrit Kaur, Principal :

, We are enclosing our invoice for professional services rendered by us. Our invoices are payable
[ ~on presentation and we would greatly appreciate if payment could be made through

J
/ ")V = RTGS/NEFT. Bank details for the same are mentioned on the invoice.

In case payment is being made by way of cheque or draft, you may send the same to
the following address:

Surbhi Gupta

Building. No. 8, 1st Floor,

Tower A, Sector 25 A,

DLF Cybercity Phase Il

Gurgaon, Haryana -122002, India

Please mention our Invoice Number and the TDS deducted by you, (if any) along with the cheque
or draft sent to us. The cheque or draft should be ir favor of Ernsts& Young Associates LLP .

» Yours sincerely

o
! For Ernst & Young Associates LLP

Encl ; As above




e ——————— e

Ernst & Young Associates LLP

DLF Cyber City, Phase |l, Sect
Gurgaon - 122002, India

Phone:

1st Floor, Tower A, Building No 8, Fax:

or-25,

(+91-124) - 457 5000
(+91-124) - 457 5200

Original for recipient

' IINLO4HRO06717

. September 23, 2020

Tax Invoice
F IRAM COLLEGE OF COMMERCE Invoice Number
faurice Nagar, Date
dorh Delhi 5 _
Delhi, DL 110007 Place of Supply . Delhi

Client GSTIN / UIN : 07AAATS7081H1ZA
Client PAN : AAATS7081H

Particulars

EY Foundation Course for the students of Shriram College of Commerce- E
Learning (37 Participants)

IGST @18

Total

(in words)
10/100 Only

Our Banker's details for remitting funds:

%

! INR ONE HUNDRED EIGHTY-FOUR THOUSAND NINE HUNDRED AND

Bank Name STANDARD CHARTERED BANK
M Block Market Building No.39 Greater Kailash Part-Ii DL India 110048
Current A/c No. : 523-0-522549-5
Beneficiary ) © ERNST & YOUNG ASSOCIATES LLP
SWIFT CODE SCBLINBBDEL
MICR 110036003
IFSC Code SCBL0036021

Please quote our Invoice Number whoen remitting funds,

Our GSTIN | 0BAAEFE1778R1ZU : ‘
HSN Code | 9992

HSN Description . Education services

Please quote our following PAN No. on the TDS Certificate to be issued by you,

PAN No | AAEFE1778R

e

o

L% ‘. e

e
M
o+

ok
et

N——"

Amount(INR)
186,695.00

28,205.10

184,900.10

1P L:[’CJ (/



shop” for Shriram College of Commerce First Year Students

' M. Consulting (“we” or “HMC") to perform professional services (the “Services”) for
e (“you or “Client”’). We appreciste the opportunity to work with the Tnstitute.

The attached Statement of Work (SOW) describes the Scope of our Services, Agenda, Specific Con ditions, Contacts,
Fees. and the necessary arrangements.

Please sign In the space provided below to indicate your agreement with these agreements and return it tous.
In case of any queries, you can reach out to us anytime,

Yours Sincerely
For and on behalf of Havish M. Consulting

mmvmummmﬁ
| Proprietor

Havish Madhvapdty
Founder — Havish M. Consulting

’

for Shrirarm College of Commerce

Principal

Enclosed:
Statement of work




I!_"-'1J_l"

SHRI RAM COLLEGE OF C n. DELHI CONSULTING |
Vr. No. .
G B O Account o 8124
Rs. P.
DEBIT I e
TOTAL | {12,000 f—
12,000 f—] TR/SRCC/64
CREDIT ! 09 AUGUST 2021
~ SRCC / 07AAATS7081H1ZA
TOTAL | 6,72,00¢ f—
i il AMOUNT
PAYABLE TO Havish H- (zn&ulh“ha (INR)
DETAILS __ 1 2 Hoofs MBA Owiewiaiaon =ACHABLE
e e 5,69,492
RUPEES Six |akh Seyen-‘--, hwo FOI:"Q/IDED s 51,254
&av&m&w\v — Wﬁ 51,254
: e 6,72,000
Received Payment 9 v KH SEVENTY-TWO THOUSAND ONLY

Mccounts) . Bursar

Principal
Shrf Ram Ciwigeipalommerce

At s | BARBOCURZON

’ .I - Universiy. orosi)
: Mau}we Nagat, Dethi-1 1000\17 &
L

23 AUGUST 2021

'\Proprlmw

For HAVISH M CONSULTIN W
M”‘” w1 @@OJ” —

" Shri kam College of Commerce

Maurice Nagar, Delhi-110007

Principal

(University of Delhi)

v 'r




HAVISH M

4 M. CONSULTING CONSULTING
dress: 392/C, Pocket-2, Mayur Vihar Phase 1, New Delhi 110091 -
Phone 9818524222

PAN: AZFPM8807K

GST: 07AZFPM8807K1ZX
Service Accounting Code (SAC): 999293

INVOICE , "
CLIENT NAME AND ADDRESS: BILL NO: TR/SRCC/64
SHRIRAM COLLEGE OF COMMERCE BILL DATE: 09 AUGUST 2021
MAURICE NAGAR, NEW DELH| 110007 CLIENT CODE / GSTIN:  SRCC / 07AAATS7081H1ZA
|
AMOUNT
! DESCRIPTION
(INR)

72 HOURS MBA ORIENTATION WORKSHOP
70+ HOURS OF VIDED CONTENT PROVIDED TO ALL STUDENTS ON TEACHABLE

BATCH OF 84 STUDENTS @ INR 8000 PER STUDENT (INCLUSIVE OF GST) R
CGST (9%) 51,254
SGST (9%) 51,254
TOTAL AMOUNT (INR) 6,72,000
TOTAL AMOUNT (INR) IN WORDS - & SIX LAKH SEVENTY-TWO THOUSAND ONLY
TOTAL DUE BY DATE 23 AUGUST 2021

All payments made in favour of HAVISH M. CONSULTING

BANK NAME BANK OF BARODA
ACCOUNT NUMBER 06230200000985
BRANCH K.G. MARG, NEW DELHI, 110001
IFSC CODE BARBOCURZON |
For HAVISH M CONSULnNﬂ
%,Ms\r

Rap P\
V, Principal

Shri Ram College of Commerce
(University of Delhi)
Maurice Nagar, Delhi-110007

. _ v




https: //mail google.com/mai/WU7IK=Io0 g oy prme=r="""

- Fwd: Partnership for Bridge...

GBO OFFICE tpgdgbo@smc.du.ac.lm

for Bridge Course_Batch 2021-23

<000 inator,gbo@srcc,du‘ac,i,n:- Mon, Jun 28, 2021 at 11:10 AM

«pgdgbo@srcc.du.ac.in>

ded message -

MADHVAPATY <havish@havishmconsulting.com>
Jun 27, 2021 at 12:25 AM

¢ Partnership for Bridge Course_Batch 2021-23

ator GBO <coordinator.gbo@srce.du ac.in>
Kaur <kaur.simrit@gmail.com>, Ms. Reena Chadha <reenachadha26@gmail.com>, Dr. C. S. Sharma

pa sccc@gmail.com>, M. Smita Sharma <smitasharma50@gmail.com>, AQ Accounts
ynts@srcc.du.ac.in>

e to engage with the institute again!

Hiawe attached:
'Emgagement Letter (MoU)

‘Cajiendar + Content
Profies

Snall confirm all the profiles by early next week.

On Fri, Jun 25, 2021 at 11:13 PM Coordinator GBO <coordinator gbo@srcc du.ac.in> wrote:
Dear Havish

We are pleased to inform you that we want to offer a Bridge Course for GBO students of Batch 2021-23 in
partnership with you. You will render all the professional services (such s designing the Course, finalising
instructors, providing delivery platform, reading material, etc.) necessa‘r'y for the course. Term end assessment and

" Y certification will also be done by you.

i
"-..J-_ -+ As discussed over the call, we will take a minimum guarantee for 78 students only and will pay on per student
‘ basis over and above. Request you to share the profile of instructors as soon as they give you confirmation

Kindly send us the Statement of Work and Engagement Letter as soon as possible. yb')%g‘ (_/tlw"
Looking forward to an amazing partnership with you. Mﬁj P,J?b W

Best Regards W‘N

Reena | Aruna |
Course Coordinators M W v 7 \adl

PGDGBO
/ﬁ'hw(}q&L O},My\ K 7 e /,
i oo L 'UWJ
= _' 2/"\ - 4 \3
Ez\gr?;gsl\ﬂadhvapaty &)} mﬁ/\ Mﬁ -

Founder - Havish M, Consulting 2
40 under 40 [Analytics Insight] ? \)(
havishmconsulting.com %))

\

I of 2 6/28/2021, 11:15
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Please signin the space provided below to'indicate your agreement with these agreements and return it tous.
In ease of any queries, you can reach out to us anytime.

Yours Stricerely

For and on behatl of Havish M. Consulting

Founder — Havish M. Consulting

/

For Shriram College of Commerce

e

Dr. Bimrit Kaur
Princinal

Statement of work

- *



Statement of Work

The Statement of W d 26 June 2021 (this “SOW”) s made by Havish M. Consulting (“we” or "HMC") and

Shriram College ¢ u“or “Cllent"), pursuant to the Agreement, dated 26 June 2021 (the
“Agreement”) be Shriram College of Commerce (SRCC) to provide training services as described
below (the “Se -

The SOW is dear art of the Agreement.

Scope of Services
The objective of our engagement is to run “MBA Orientation Workshop” for the students of SRCC. The workshop
comprises of: = 8

* 72 hours of Live Virtual sessions to the designated students of SRCC.

= Access to 80+ hours of e-learning modules hosted on Teachable, that includes Excel, PowerPaint, Word,
Google Sheets, Power Bi, Tableau. R, Python, Knime

A1 SRCC accepts that HMC will be using its judgment when determining the cantents of the presentation. The training
h will be conducted by Havish Madhvapaty, and other Senior trainers represented by HMC. The training will take place
e on the days and dates agreed between both the parties,

b Agenda
) o Total 72 hours of Live Virtual sessions.
L ¥ 14 hours of Live Virtual sessions (combined batch) conducted on Zoom.
f ;l 52 hours of_lee \firtuai sessions (26 hours per batch) conducted on Zoom (Individual batch with max 45 students),
I ' 6 hours of Live Virtual sessions (combined batch) with participant presentations to measure learning outcomes and
B racelve feedback.
. I~ Topic Hours Trainer |
Choosing the Right Career Path - Create Your Portfollo + Build your Resume (Combined Batch) o Havish
Data tnslghts and Modelling using Microsoft Excel 8 Havish
W Businessintelligence and Automation on Power Bl B a 10 Havish
|_ T Data Visualization and ashboard with Tabieau | & Havish
Fimance for Everyone (Combined Batch) - - ] 2 TBC
;_— - ) " Consulting for Everyone {Combined Batch) 5 ) Havish
e Introduction to Programming with Python 2 Anubhav
1‘ S ______T_gchnomgy Bootcamp - Machine Learning and Artificial Intelligence i' _2 _ Anubhav
| l—-— e Technology Bootvamp — Blockchain (Combmed Batch) x0T 2 Anubhayv
‘ Design Thinking (Combined Batch) ) Rchg.gg?noy
L Storytelling with PowerPoint (Combined Batch) 2 | Havish
introtuction te Sustalnability (Combined Batch) 2 Nikhil
a Final Presertation - Measurement of Learning Outcome 6 | Havish

The students will be given 3 days preparation break.

Students will work in Group of 5.

The final presentation for 10 minutes will be given by students to measure learing cutcomes.
Feedback will be shared for each presentation,

Specific Conditions

After the services have been completed, we may disclose or present to prospective clients, or otherwise in our
marketing materials, that we have performed the Services for you, and we may use your name solely for that
purpose, in accordance with applicable professional obligations, In addition, we may use your name, trademark,

b
b
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HAVISH M
HAVISH M. CONSULTING CONSULTING

Address: 392/C, Pocket-2, Mayur Vihar Phase 1, New Delhi 110091
Phone 9818524222

PAN: AZFPM8807K

GST: 07AZFPM8807K1ZX

Service Accounting Code (SAC): 999293

INVOICE
CLIENT NAME AND ADDRESS: BILL NO: TR/SRCC/54
SHRIRAM COLLEGE OF COMMERCE BILL DATE: 12 APRIL 2021
MAURICE NAGAR, NEW DELHI 110007 CLIENT CODE / GSTIN: SRCC/ 07AAATS7081H1ZA

AMOUNT
DESCRIPTION

(INR)
12 HOURS BUSINESS INTELLIGENCE + DATA ANALYTICS WORKSHOP 1.20.000
50+ HOURS OF VIDEO CONTENT PROVIDED TO ALL STUDENTS ON TEACHABLE e
CGST (9%) 10,800
SGST (9%) 10,800
TOTAL AMOUNT (INR) 1,41,600
TOTAL AMOUNT (INR) IN WORDS ONE LAKH FORTY ONE THOUSAND SIX HUNDRED ONLY
TOTAL DUE BY DATE 19 APRIL 2021
All payments made in favour of HAVISH M. CONSULTING

BANK NAME BANK OF BARODA
ACCOUNT NUMBER 06230200000985
BRANCH GROUND FLOOR, 17 VIJAYA BUILDING, BARAKHAMBA ROAD NEW DELHI 110001
IFSC CODE BARBOVJBARO

For HAVISH M CONSULTIN
bt

Proprietor



KPMG Assurance and Consulting Services LLP Telephone: +91 120 386 8000
Advant Navis Business Park, 6th Floor, Plot No 7, Tower A Fax . +91 120 386 8999

W
K'PMG MNoida,UP,201305,India Internet; www.kpmg.com/in

Tax Invoice
ORIGINAL FOR RECIPIENT

RN Ba9d12b7475ccc74a702a0c16c1e58a42180921 dbf040c8519b7732902904709
Ack No 142110183500512
Ack Date 25-JAN-2021

SHRIRAM COLLEGE OF COMMERCE
=

SHRIRAM COLLEGE OF COMMERCE, MAURICE MNAGAR, Invoice Date - 25-JAN-21
Dathi-110007., Daihi, India Tax Invoice No ' KPMG-UP/401266
SSTIN No: OTAAATSTOBTHIZA GSTIN No - D9AAAFK1415H1ZP

San AAATSTORH PAN AAAFK1415H

Kind Afiention SHRIRAM COLLEGE OF COMMERCE

P - - = - —— S e i o . O Y O S S s = - L

Description of Amountin INR
Afi=r compietion of batct 154.237
Total Taxable Value 164,237

IGST @ 18 % 27.763

Total 182,000

(INR One Lakh Eighty-Two Thousand Only) o T s it
HSN Code : 9992 Description of HSN : Education services

s I N

—aam mm = = T - e = - - e i - S s —— i EE

Our charges become payable when this bill is issuea. This account is therefare now due for settlemert. Please detach the slip below and send il with your cheque or
bank draft (if outside India) to the accounts department at the above address. -
Payment can also be made directly to the following Bank Account, quoting the Tax invoice number and undel intimation to us of the remittance being made,

i Cheque/draft in favour of KPMG Assurance and Consulting Services LLP
| Beneficiary Bank Name The Hongkong and Shanghai Banking Corporation Ltd
Beneficiary Bank Address NO. 25, BARAKHAMBA ROAD NEW DELHI 110 001
Beneficiary IFSC Code HSBC0110002
UPI1ID KPMG@HSBC
Beneficiary Account No To the credit of KPMG Assurance and Consulting Services LLP, Account No.1663467 18001
Nostro Bank Details
Intermediary Bank_Name Intermediary Swift Code Intermediary Account No Intermediary Additional Info
KOTAK Mahindra Bank Limited, NewDelhi KOTAK Mahindra Bank Limited,
NewDelhi_01722540000245

Please share payment advice / invoice details al ar-india@kpmg.com

i i e, <. S - T i e PRpp— P - ci— S ————————— T RSttt R L R LS e - N—————————— T TR PR A st f

Client Name SHRIRAM COLLEGE OF COMMERCE Client Code: 1641240 Project Code: 1558729
Place Of Supply: SHRIRAM COLLEGE OF COMMERCE, MAURICE NAGAR, Delhi- State Name/Code: Delhil07 | Reference No: 1343587
110007, Delhi, india

Whether the tax is payable under the Reverse Charge: No

»~ W3
X \p CQJWW

M '? eélw“’a/ | -*
> (e,
V7 INCIPAL

m Collere of Comumerce

Ainversiy of Delhi) e S e
Maurice Mager, Dtlni—ll{}&ﬁg =
ANUJ MEHXTA

KPMG Assurance and Consulting Services LLP, an Indian KPMG (Registered) (s partnership firm with Regisiratian MNa B E145) converla Registered Office ! '59
Hrmitad kablity parinership and a mambar firm of the KPMG nin KPMG Ascurance and Consulling Services LLF (8 Linvfed Ly paArimarship 15t Fioor, Lodha Excau® E&al oL n
network of independent memiber firms afliiated with KPMG with LLP Registration No, AAT-D367) wih effect from July 23, 2220 NM Joshl Marg

Imernational Cooperalive ("HKPME nermational”), 8 Swres Mahalaxmi, Mumbai - 400 011
Brifty




k; g H i E KPMG Assurance and Consulting Services LLP

Telephone: +91
Embassy Golf Links Business Park Siephane: vE1 3 0B 0 2000

Fax: +91 B0 6833 5999
Pebble Beach B Block, 1st and 2nd Floor Web www kpmg comfin
Off Intermediate Ring Road Email indiawebsite@kpmg com

Bengaluru 560 071 India

Strictly Private and Confidential

To,

Dr. Simrit Kaur,

Pricipal,

Shri Ram College of Commerce,
University of Delhi North Campus,
Muaurice Nagar, Delhi - 110007
Ph-011-27667903, 011-27666519

29-09-2020

Letter of Engagement for Competency Development Program on Lean Six Sigma Green Belt

Dear Dr.. Simrit Kaur,

rJ

I am writing to confirm the terms of the engagement agreed between Shriram College of
Commerce (“Shriram College of Commerce” or “you™ or “Company™) and KPMG Assurance
and Consulting Services LLP (“KPMG" or “we”) to deliver Competency Development
Program on Lean Six Sigma Green Belt.

This engagement letter “EL" overrides all prior communications exchanged between us on this
account. All changes to this EL shall have to be mutually agreed in writing between us.

Background

We will be providing to the participants identified by Shriram College of Commerce,
competency development program on LEEin Six Sigma mgthodology. KPMG has long
established curriculum and methodology to impart such programs. The Lean and Six Sigma
concept may be applied by participants to ensure repeatability of desired process outcome
over period of time or may be used for elevating their individual competency to perform
work.,

Services. We have discussed and agreed with you the Services which we will provide to
you in accordance with the terms of this EL.

4.1. Scope of Work

The scope of this engagement covers provision of Competency Development Program for
Six Sigma Green Belt with 25 participants. The current engagement scope covers only
Delhi location of Shriram College of Commerce.

4.2 Scope Exclusion

a) We do not render legal services and, therefore, none of the services rendered under
this EL orany part thereof shall be deemed to be legal services. In respect of all legal
issues, you may consult your legal advisors and act in accordance with their advice,

')1,/



KPMG

b) We will not, pursuant to this letter, perform any management functions for you nor

make any decisions relating to the services provided by us in terms of this
letter. You are responsible for making management decisions, including accepting
responsibility for the results of our services. Additionally. management is
responsible for - designating a management-level individual or individuals
responsible for overseeing the services provided, evaluating the adequacy of the
services provided, evaluating any findings or recommendations and monitoring

ongoing activities.

5. Client Responsibilities
All arrangements necessary to conduct program will be provided by you. This includes:
Venue, Projector to connect to our laptops, 2-Color Markers, collar mike (if required) and
related more. All food and refreshment arrangements for faculty and participants shall be
arranged and borne by you
6. Our Deliverable
KPMG will deliver training based on below mentioned broad table of content:
Training Phases Deliverable Pre-Requisites
Green Belt Define Understand 6¢
Project definition and Charter e Team player
High level Process Mapping - * Statistical
COPIS knowledge is
Measure CTQ Characteristics — Learning desirable
and usage of tools like FMEA, * A process oriented
C&E diagram, Pareto and class room culture
detailed process mapping
Performance standards
Measurement system Analysis
(MSA)
Analyze Graphieal Analysis  a*
Process Capability — Cp. Cpk.
Identify variation sources —
Hypothesis testing
Improve Brainstorming techniques and
TRIZ
Pilot Improvement plans
Control Introduction to Control Plans
SPC - Control charts for Variable
and Discrete Data
Project closure
7. Our Engagement Team

7.1. Our Engagement-team will comprise of the following: -

a.  Dr, KK Raman, Partner, Engagement Partner

b. Nitesh Jain, Director, Engagement Director

¢, Vishal Singh, Manager, Engagement Manager

d. Duly qualified trainers

W




KPMG

We may involve other team-members as may be required for this engagement. These
team- members may belong to our associated entities. However, we will remain
responsible for all the work performed by them.

8. QOur Charges

8.1.

8.2.

83.

84.
8.5.

Our professional-fee for the services at Paragraph-4 above will be INR 162.500/- (One
Lakh Sixty-Two Thousand Five Hundred Only). Any addition to 25 participants will be
charged at INR 6,500/ per participant.

This professional-fee will be payable by vou to us as per the following schedule: -
a. After completion of batch- Rs 162,500/-

Total - Rs 162,500/-
Following expenses and charges will be payable by you: -

a) All charges viz. the taxes, duty, cess and all other levies as instituted by the statute
that become applicable to any of the services provided under this engagement.
Our fees are inclusive of applicable taxes that will be payable at actuals.

b) This fee does not include additional expenses such as Airfare, Local Conveyance,
food and accommodation for the faculty, copying / duplication of training material,
shipping charges, as applicable. The same will be charged on actual, if required.

Invoices will be presented on a periodic basis and are payable on presentation.

If unforeseen circumstances arise that warrant additional expenses that cause us to be
unable to deliver our services within the fees stated above, then we will notify you
of such  circumstances.

Other terms and conditions governing our relationship

9.1,

We accept this engagement on the basis that our.'General Terms of Business™ will
apply to this work and govern our relationship with you. This letter is the
“Engagement Letter” mentioned in our General Terms of Business,

&

. Special Circumstances

10.1. During the engagement term, each party shall keep the other party reasonably informed

of any events which relate to COVID 19 or any other such situation that
a) is not existing or reasonably foreseeable at the date of the Engagement Letter: AND

b) which will materially and adversely affect the notifying party’s ability to perform its
obligations under the Engagement Letter.

. Each party will implement mitigation measures to enable the Services to be performed

so far as reasonably practicable in the circumstances, including without limitation:

a) reducing travel (particularly international travel) and in-person meetings to the
minimum necessary level;

b) at the party’s premises, implementing such infection control procedures as are
recommended or required by official bodies in the applicable location;




KP

MG
c) implementing internal corporate policies which permit and encourage individual
remote working, and technical systems to enable individual remote working;

d) implementing telepresence, audio conference, videoconference, and other systems
for collaborative working; and

e) complying with the regulations, notifications, advisories etc. issued by the relevant
authorities (“Notifications™).

10.3. If, as a result of the global COVIDI9 virus situation, performance by a party of its
obligations under the Engagement Letter are rendered impossible or impracticable, the time
for performance of such obligations shall be extended by such period as is reasonable in the
circumstances without any liability on the nonperforming party, PROVIDED THAT the
party in question is complying, and continues to comply, with its obligations pursuant to
paragraph 10.2 above.

11. Confirmation

I'.1. We shall be grateful if you will kindly acknowledge your agreement with the terms
and conditions of this EL by signing one copy of this letter and affixing your company
seal in the space provided below and returning it to us.

I1.2. If this EL were not to be in accordance with your understanding of our agreement,
then we shall be pleased to receive your observations and provide you with
information as you may require.

Kind regards

yours sincerely

Full Signature
Dr. KK Raman & «

Partner

I have read this letter and confirm agreement with its terms.

Full Signature

Name: Dr. Simrit Kaur
Title/ Position. Principa

T ~_',,-_"I:‘II .- . G' (_,00{ .WY

) G160

Company seal NN il
Date

Duly authorized for and on behalf of Shriram College of Commerce
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General Terms of Business — Training Services

1. Definitions

“Additional Terms™ means any other terms applicable to the Services included with or referenced in the Engagement Letter and these General
Terms.

“Agreement” (or “Services Contract”) means the contract formed by the Engagement Letter. these General Terms, and any Additional Terms.
“Affiliate(s)” means any legal entity that, direetly or indirectly, controls, is controlled by, or is under common control with you.
“"Charges" means the fees, expenses and applicable taxes payable for the Services.

“Confidential Information™ means any information that has been or will be made available, dirsctly or indirectly, by one Party to the other in
connection with the Services, that is marked or communicated as confidential or whose nature is such that a recipient would reasonably consider
it confidential, including, without limitation, business plans, proposals, product development details, methodologies, software code and
specifications, and financial information, Confidential Information excludes Excluded Information.

“Deliverable™ means any advice, report, training material or other product of the Services provided to you in any form including but not limited
to the content of the Program,

“"Engagement Letter” means the letter sent to you referencing these General Terms,
“Engagement Team™ means KPMG Persons who are individuals delivering the Services.

“Excluded Information™ means information that: (i) is or becomes generally available in the public domain through no fault of either the
receiving Party or those to whom the receiving Party has disclosed the Confidential Information; or (ii) was previously known to the receiving
Party free of any obligation of contidence; or (iii) becomes available to the receiving Party free of any obligation of confidence from & third
party who 1o the reasonable belief of the receiving Party is entitled to make such disclosure: or (iv) was developed by a Party independently of
the other’s Contidential Information.

“General Terms™ means these terms and conditions.

“IPRs™ means all intellectual property rights including all rights in and to inventions, utility models, patents, copyright and related rights, trade
marks, logos, trade and business names, rights in designs, rights in computer software, database rights, moral rights, rights in Confidential
Information (including know-how and trade secrets), in every case whether registered or unregistered and all similar or equivalent rights or
forms of protection (whether now or in the future) in any part of thé world and referend®s to “IPR™ means any of them.

“KPMG™ or "we” (and derivatives) means KPMG contracting party as identified by the Engagement Letter.

“KPMG Persons” means KPMG, and each and all of our partners, directors, members, employees and agents together with KPMG
International and other members of network of KPMG International Cooperative (each a “Member Firm”) and any entity associated with us
or a Member Firm, and each and all of its partners, directors, employees and agents. and "KPMG Person™ means any one of them,

“Other Beneficiaries” means any Person identified in the Engagement Letter as a beneticiary of the Services or of any Deliverable other than
you. on whose behalt or for whose benefit you sign the Engagement Letter.

“Other KPMG Person(s)” means KPMG Persons who are not members of the Engagement Team.

“Party” means either of KPMG and you and “Parties” shall mean both KPMG and you.

“Person” means individuals. corporate and unincorporated bodies.

“Program™ means the training program to be undertaken by KPMG in accordance with terms of the Engagement Letter.

“Services” means the services to be delivered by us under the Engagement Letter.
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“Unpublished Price Sensitive Information™ means any information, relating to a company or its securities, directly or indirectly, that is not
generally available, which upon becoming generally available is likely to materially affect the price of the securities and shall, ordinarily
include, but not be restricted to, information relating to the following:

(1) financial results;

(i1) dividends;

(1ii) change in capital structure;

(1v) mergers, de-mergers, acquisitions, delistings, disposals and expansion of business and such other transactions;
(v) changes in key managerial personnel,

“you” (and derivatives) means the addressee(s) of the Engagement Letter and, if the context requires, Other Beneficiaries.
2. The Agreement

2.1 This Agreement sets out the entire agreement between the Parties in connection with the Services and extinguishes all previous agreements,
promises, representations and understandings between the Parties, whether written or oral, to the extent only that they relate to its subject
matter.

2.2 In entering into this Agreement, neither Party has relied on any statement, representation, assurance or warranty (made innocently or
neghigently) that is not set out in this Agreement,

2 3 If there is any inconsistency between the Engagement Letter and any other part of this Agreement, the Engagement Letter prevails to the
extent necessary to resolve the inconsistency, If there is any inconsistency between these General Terms and any Additional Terms, the
Additional Terms prevail to the extent necessary to resolve the inconsistency.

2.4 Any changes to this Agreement must reference this Agreement, be in writing and signed by all Parties.

2.5 If any provision of the Agreement is found by a court of competent jurisdiction to be invalid, unenforceable or illegal in whole or in part
tor any reason such decision shall not affect the validity, enforceability or legality of the remaining provisions hereof and the Agreement will
be construed as if such invalid, illegal or unenforceable provision was not a part of the Agreement.

3. Our responsibilities

3.1 The Services shall be delivered with the reasonable skill and care expected from a skilled and experienced Person engaged in providing
services similar to the Services, in a similar context, and in compliance with applicable laws. We do not render legal services and, therefore,
none of the Services rendered under the Engagement Letter or any part thereof shall be deemed 1o be legal services,

3.2 The Services will be provided by an Engagement Team, including any individuals named in the Engagement Letter. We try to minimise
team changes, but, where necessary, we may change team members for others of equivalent skills and we shall iry to give youreasonable notice
of any changes.

3.3 When we work at your premises, we shall comply with applicable site policies communicated to us.
4. Your responsibilities

4.1 You shall provide (and procure that your personnel and representatives provide), in a timely manner, such cooperation, information,
documents and access to personnel, premises, systems and facilities, as we reasonably need or request and you shall obtain all necessary licences
and permissions. You shall provide a safe and appropriate working environment and perform any actions required of you under this Agreement.

4.2 You shall inform us of any changed circumstances or information that may have an impact on the Services and shall ensure that the
personnel with whom we deal have the required skills and information.

4.3 You are responsible and accountable for managing your affairs, deciding on what to do after receiving any Deliverable and implementing
any advice or recommendations,

4.4 You are responsible for making any notifications, registrations and disclosures required of you by law or regulation.

4.5 We may communicate with you by electronic mail where any such person wishes us to do so, on the basis that in consenting to this method
of communication you accept the inherent risks (including the security risks of interception of or unauthorised access to such communications,
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the risks of corruption of such communications and the risks of viruses or other harmful devices), that to the extent permitted by law we may
intercept such communications in order to monitor them for internal compliance or other statutory purposes, and that you shall perform virus
checks. We may, at your request, send documents to an electronic storage facility hosted or controlled by you or at your direction, in which
event you shall be responsible for security and confidentiality at such facility.

5. Ownership

5.1 We own all IPRs in any Deliverable and the Program (including any part thereof), except to the extent that the Deliverable incorporate your
or third party pre-existing intellectual property which you or they shall continue to own. We shall retain ownership of our working papers,

5.2 You own any Deliverable in its tangible form on payment in full of our Charges and shall use the Deliverable subject to the terms of this
Agreement.

6. Our advice and use of information

6.1 We may provide advice orally, in draft or interim form, but our later written advice or final written report supersedes anything provided
earlier.

6.2 You should not rely on any draft or interim advice, It we give you oral advice, and you wish to rely on it, you shall inform us and we will
provide it in writing. You should only rely on our written advice.

6.3 We may rely on any instructions, requests or information supplied by any Person whom we reasonably believe to be authorised by you for
such purpose.

6.4 Unless set out in the Engagement Letter, if we receive information from you or from other sources in connection with the Services, we will
rely upon it without independent verification.

6.5 Unless a part of the Services, we will not update the Services or the Deliverable after we have delivered the final Deliverable.

6.6 We cannot predict future events or circumstances, and you should not interpret our advice, forecasts or recommendations as a prediction or
guarantee of any outcome.,

6.7 Unless otherwise agreed, our Services and Deliverable are provided for your internal use only and on the basis that you shall not quote our
name or reproduce our logo in any form or medium without our prior written consent, The Deliverable shall not be disclosed to any other
Person without our prior written consent except as permitted under the Agreement or except as required by law or by a competent regulatory
authority (in which case you shall, if permitted by law or regulation, promptly inform us).

6.8 You may disclose the Deliverable to your insurers, legal and other professionaf* advisers if seeking advice m relation to the Services,
provided that you inform them that; (i) the Deliverable shall be kept confidential: and (ii) to the fullest extent permitted by law, we aceept no
liability to them in connection with the Services or the Deliverable. You may disclose the Deliverable to your Affiliate(s) who shall then be
considered as Other Beneficiaries.

7. Confidentiality

7.1 The Parties shall keep each other’s Confidential Information confidential and use it only to perform or receive the Services or for exercising
their rights or performing their obligations under this Agreement. Each Party will protect the Confidential Information it receives as it would
protect its Confidential Information, and exercise at least a reasonable standard of care.

7.2 Unless you tell us otherwise in writing, we may share Confidential Information with your other advisers. The Parties may disclose
Confidential Information if required by applicable law or regulation but only to the extent required by such law or regulation. The Partics may
disclose Confidential Information to their advisors and insurers in relation to any dispute relating to this Agreement, in which event such
disclosure shall be done privately and in confidence only,

7.3 Subject to our confidentiality obligations herein, we will retain your Confidential Information in accordance with our record retention
policy. We may share information relating to you and the Services (including Confidential Information) with KPMG Persons and our
subcontractors and that information may be accessed by parties who facilitate or support our business, We are still responsible for ensuring
confidentiality if Confidential Information is shared with or accessed by such parties.
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7.4 We may use information We obtain in performing the Services, anonymised and/or aggregated so that no Personal Data or commercially
sensitive information is disclosed. for development of expertise and know-how, benchmarking, ana lytics, quality assurance and other purposes
related to our business.

7.5 Except as required by law or as set torth in this paragraph, neither Party shall acquire hereunder any right 1o use the name or logo of the
other Party or any pan thereof, and any such use shall require the express written consent of the other Party, You agree that we may refer tg
You in our internal and external communication, indicating the general services rendered Further, for purposes of the Services, you hereby
grantto us a limited, revocable, non-exclusive, non-transferable, paid up and royalty-free license, without right of sublicense, to use your name
and logo solely for presentations or reports to you or for internal presentations and intranet sites,

7.6 You are aware of the provisions of the SEBI (Prohibition of Insider Trading) Regulations, 2015, including amendments thereof,
(“Regulations™) and the resirictions imposed thereby and agree to comply with the same. You agree to use all our oral and written reports and

all other communications and advice, strictly in accordance with the Regulations. You shall inform us in writing, in advance in case the

domain will be treated as Confidential Information, We recommend that you obtain legal advice to ensure that the information supplied to us
IS 1ot 1n contravention of any applicable laws and regulations.

8. Our Charges

8.1 We shall invoice you as per the Engagement Letter for the Charges which shall be payable on presentation of our invoice (or at such other
time as may be specified in the Engagement Letter) without set-off,

8.2 Upon termination of the Agreement we shall be entitled to payment of our Charges for Services performed up to the date of termination, In
this event, our Charges will be caleulated at our agreed hourly rates (or if none are agreed then our relevant standard rates) at the time the
Services were performed,

8.3 Where there is more than one addressee of the Engagement Letter, unless the Engagement Letter provides otherwise, each of you shall be
Jointly and severally liable to pay our Charges,

8.4 If we are required by law, ora regulatory or parliamentary body in any proceedings, forum, or investigation (in which we are not a party or
participant but you are) to provide information or produce documents relating to the Services, you shall pay our tees incurred in satistying such
requirements based on our standard rates at the time and any costs, expenses and applicable taxes.

9. Managing conflicts of interest ’

9.1 KPMG Persons may be delivering services to, or approached to deliver services 1o, or act for another party or parties during and after this
chgagement with interests that confljet with or are adverse 1o yours (a “Conflicting Party” or "Conﬂicting Parties”),

9.2 KPMG Persans are free to deliver services to Conflicting Parties, but where the interests of any Conflicting Party directly contlict with

* yours in relation to the subject matter of the Services then the Engagement Team shall not deliver services to the Conf] icting Party and Other

KPMG Persons may only deliver services 1o the Conflicting Party where appropriate Barriers are in place, Where thig process is followed and
such Barriers are in place, you agree that this will be sufficient to manage such conflict,

9.3 “Barriers” means reasonable safeguards to facilitate the protection of our clients” interests, through information handling procedures angd
deployment of professionals.

10. Third parties and their rights
10,1 KPMG Persons (who are not the KPMG contracling Party) may exercise rights given to them in thig Agreement,
10.2 The Parties may end or vary this Agreement withoiut anyone else's consent, including any Other Beneficiaries,

10.3 You agree to and accept the provisions of the Agreement on your own behalf and as agent for Other Beneficiaries. Other Beneficiaries (if
any) acquire rights and become subject to obligations under this Agreement as if they had each si gned a copy of the Engagement Letter ang
agreed 1o be bound by it
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10.4 Except as provided herein, the Agreement shall not create or give rise to, nor shall it be intended to create or give rise to, any third party
rights. No third party shall have any right to enforce or rely on any provision of the Agreement which does or may confer any right or benefit
on any third party, directly or indirectly, expressly or impliedly.

11. Circumstances beyond Your or our contryl

I 1.1 Ne Party shall be in breach of its obligations under this Agreement or incur liability to the other if that Party is unable to comply with this
Agreement due to any cause beyond their reasonable control,

11.2 If such an event occurs, the affected Party shall, as soon as reasonably practical, notify the other, who may suspend or terminate this
Agreement by giving seven days’ notice, taking effect if the affected Party has not recommenced the performance of its obligations in that
period.

12. Waiver, assignment and sub-contractors
121 Failure by a Party to exercise or enforce any rights under this Agreement is not a waiver of such rights.
12.2 No Party may assign the benefit of this Agreement.

12.3 We may appoint sub-contractors to assist in delivering the Services. but we remain responsible for performing the Services and we shall
procure that they treat your Confidential Information under obligations equivalent to those in this Agreement. Where any sub-contractor is not
a KPMG Person we will notify you first.

13. Limitations on our liability

13.1 Our liability and that of any KPMG Person, in aggregate, to you and to Other Beneficiaries for direct losses or damages under this
Agreement and for all claims connected to it, in contract, tort Uncluding negligence), statutory liability or otherwise, shall be limited to the fee
paid to us for the Services in last twelve (12) months preceding the claim. Nothing in this Agreement limits our liability for direct losses or
damages arising from our fraud.or deliberate breach of duty or any other liability which cannot be limited by law

13.2 In no event shall we (including KPMG Persons) be liable for loss of profits, goodwill, anticipated savings or wasted time and for indirect,
$pecial, incidental, exemplary, punitive or consequential loss, claims, costs, expenses or damages.

13.3 Where there is more than one beneficiary of the Services (a “Beneficiary") the limitation on ourliability in clause |3, shall be apportioned
by the Beneficiaries amongst them. No Beneficiary shall dispute or challenge the validity or operation of clause 13.1 on the grounds that no
apportionment has been agreed or that the share of the limitation amount apportioned to any Beneficiary is unreasonably low. In this clause,
“Beneficiary™ includes you and Other Beneficiaries, " a

13.4 Neither you nor any Other Beneficiaries shall bring any claim against any KPMG Person except KPMG in respect of loss or damage
suffered by you arising out of or in connection with this Agreement or the Services. This clause is enforceable by any KPMG Person.

13.5 Any claim from you or Other Beneficiaries in respect of loss or damage suffered as a result of, arising from or in connection with the
Agreement must be made within three years from the date on which the activity giving rise to the claim was performed. For the purposes of
this clause, a ¢laim shall be made when court or other dispute resolution proceedings are commenced,

14, Third Party Claims

14.1 You shall indemnity and hold us harmless from time to time and at all times hereafter, from and against all losses, damages, costs, charges
and expenses, harm or injury suffered or incurred by us or any of us anising out of any third party notices, claims, demands, action, suits or
proceedings given, made or initiated against us on account of or in relation to (a) the performance, by us or any of us, of all or any of our
obligations hereunder (provided that this indemnity under (a) shall not, however, be applicable to the extent that any such notices, claims,
demands, actions, suits or proceedings are found by a competent court w its final judgement to have resulted primarily from our wilful default
in performing the Services described in the Engagement Letter) or (b) use. copy, duplication or distribution of the Deliverable or Program (or
any part thereof) in a manner because of which there is any claim made or threatened against us () any default committed by you in the
performance of all or any of your obligations hereunder, including breach of our IPRs or (d) providing a copy of our Deliverable to a third
party as agreed by us under the Engagement Letter or in writing otherwise.

14.2 [f any payment is made by you under this clause you shall not seek recovery of that payment from us at any time.
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14.3 In this clause “us" shall include KPMG Persons and “you" shall include Other Beneficiaries.
15, Termination

15.1 Either you or we can terminate this Agreement by giving at least 30 days’ prior notice to the other at any time. Except where termination
1s on account of elause 15.2 below, it is agreed berween the Parties that (i) the Program shall be completed for all participants who have not
finished the Program as on the date of the termination notice by a Party; and (ii) there will not be any new intake of participants for the Program
from the date of termination notice by a Party.

15.2 We may terminate this Agreement immediately if* (i) there is a change of law, rule, regulation or professional standard, or circumstances
arise that we reasonably believe would cause the relationship between the Parties to violate such law, rule. regulation or professional standard
or would prejudice any KPMG Person's ability to comply with applicable independence requirements: or (ii) we believe a confliot of interest
cannot be managed, but in that case we shall consult you before we do so.

15.3 Termination shall not affect any rights accrued before termination. Clauses 1. 4, 5, 6, 7. 8. 9, 10,12, 13, 14, 15.3, 17, 18, 19 and 20 shall
survive termination of this Agreement, together with any other provision which, by implication, is intended to survive,

16, Data Protection
16.1 This clause 16 applies to personal data provided to us by you or on your behalf in connection with the Services (“Personal Data"),

16.2 You warrant and represent that you have necessary consent, have provided any necessary notice and have complied with
provisions/actionable required under applicable data protection laws to disclose Personal Data to us in connection with the Services.

16.3 We will take appropriate technical and organisational steps to protect against unauthorised or unlawful processing of Personal Data and
accidental loss or destruction of, or damage to, Personal Data,

10.4 We shall process the Personal Data as reasonably required (i) to provide the Services; (i) for our reasonable business purposes including
facilitation and support of our business and quality control; and (iii) to meet our legal and regulatory obligations. We may share Personal Data
with KPMG Persons, our subcontractors or other parties who facilitate or support our business. We will only make such a disclosure where it
is required in connection with such purposes and in compliance with applicable data protection laws,

16.5 With respect to Personal Data received under the Agreement, we shall notify you promptly: (i) upon receiving a request for Personal Data
orother request from a data subject, or if we receive any elaim, complaint or allegation relating to the processing of the Personal Data; (i1) upon
becoming aware of any breach of security leading to the destruction, loss or unlawtul disclosure of the Personal Data in our possession or
control.
- &

166 You shall inform us if you disclose any Personal Data that is subject to and governed by the General Data Protection Regulation (EU
2016/679) (“EU Personal Data™). Upon notice trom you under this sub-clause, the Parties shall enter into a mutually agreed data protection
exhibit goveming the processing of such EU Personal Data which shall form part of these General Terms,

" 17. Notices

I7.1 Any notice under this Agreement shall be in writing which includes email, exceptas set out in this clause. Any notice alleging breach or
terminating this Agreement must be delivered by first class registered post (or overseus equivalent) to or left (and signed for) at our respective
addresses in the Engagement Letter (or such other address as may be notified in writing) addressed to the lead persons of the relevant Party
named in the Engagement Letter and copied to the Parties' respective General Counsel.

18. Legal and regulatory compliance

18.1 Notwithstanding any other provision in this Agreement, each Party agrees that the other may make any notifications, registrations and
disclosures required by applicable law or regulation and this may include disclosures or registrations relating to money laundering, tax
requirements, and criminal or regulatory investigations.

18.2 To the best of its knowledge and information available, each Party represents, warrants and covenants that as on the date of the Engagement
Letter, each Party is in compliance with and has not violated applicable laws and regulations relating to anti-corruption and anti-bribery (“Anti-
Corruption Laws™) and agrees and undertakes that it shall not violate Anti-Corruption Laws, including through any of its employees, officers.
atfiliates, agents, subcontractors, or any other third party acting on Its behalf.
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19. Law and jurisdiction

19.1 This Agreement and all disputes arising on any basis from, under or in connection to it shall be governed exclusively by Indian law and
subject to the exclusive jurisdiction of the courts in New Delhi, India,

20, Feedback on our performance

20.1 o help us improve our service, we may send you a feedback request. Your feedback will be seen by the Engagement Team leader and
the account Lead Partner,

20.2 If you want to comment on or complain about the Services to someone who is not invalved in their delivery or management of your
account, please contact Akhil Bansal, Deputy CEQ, at a bansaliwkpmg.com,
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¢) implementing internal corporate policies which permit and encourage individual
remote working, and technical systems to enable individual remote working;

d) implementing telepresence, audio conference, videoconference, and other systems
for collaborative working; and

¢) complying with the regulations, notifications, advisories etc. issued by the relevant
authorities (*‘Notifications™).

10.3. If; as a result of the global COVIDI9 virus situation, performance by a party of its
obligations under the Engagement Letter are rendered impossible or impracticable, the time
tor performance of such obligations shall be extended by such period as is reasonable in the
circumstances without any liability on the nonperforming party, PROVIDED THAT the
party in question is complying, and continues to comply, with its obligations pursuant to
paragraph 10.2 above.

| 1. Confirmation

LI.1. We shall be gratetul if you will kindly acknowledge your agreement with the terms
and conditions of this EL by signing one copy of this letter and affixing your company
seal in the space provided below and returning it to us.

L1.2. If this EL were not to be in accordance with your understanding of our agreement,

then we shall be pleased to receive your observations and provide you with
information as you may require.

Kind regards

yours sincerely
KRISHNAMURTHY Digitally signed by

KRISHNAMURTHY

KOTHANDARAM KOTHANDARAMAN

Date; 20200930 12:20:26

Full Signature +05'30

Dr. KK Raman
Partner

[ have read this letter and confirm agreement with its terms.

Full Signature d»')

Name: Dr. Simrit Kaur THL"F-&;
Chllepge of Commad

Title/ Position: PrincipaPh’ Ham

{EITIVELSHY of Lwethoy

Mar e Nag, Deltu- b il

(&

Company seal
Date

Duly authorized for and on behalf of Shriram College of Commerce

X @MW
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URSTYLECOACH

SBTYLE WARDROBE COLOR CONSULTANT

P-10/3, DLF phase I Gurgaon-122002

INVOICE
Bill To: ORIGINAL
Shri Ram College of Commerce- Global Business Operations
University Of Delhi, University Enclave, Ne. USC/ 20/001
New Delhi, Delhi 110007 India 24-Jun-20
Kind Attention: Mrs Reena Chadha
Subject: Virtual Workshop
S.No. PARTICULARS AMOUNT(Rs)
1|Consultancy Charges for Virtual Workshop GBO Students 30000.00
'Y
Total (Rs.) 30000.00
Amount in Words: Rupees Thirty Thousand Only
Thanking Y ou.
For UrStyleCoach
o2
(AUTHORISED SIGNATORY)

Contact: +91-9810000799 Email: info@urstylecoach.com
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Estimated Expenditure for July 2020

Particulars INR
Tentative cost of Designing Brochure & Placement Report | (Appendix 1) 50000
| Subscription for six months for Cisco Webex Platform (Appendix 2) 13545
| Webinar - Gifts and Mementos INR 5000 (Tentative) 5000
I Cost of Workshop by Ur style (Appendix 3 &4) 30000
| Cost of Workshop by Manjir Gupta ‘ (Appendix 5) 21000
| TOTAL 119545
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Shn Ram College of Commearce Mail - Fwd 7 Day Madule a= desired

z Oﬁjm il Coordinator GBQ <coardinator.gbo@srcc.du.ac.in>
Fwd: 7 Day Module as desired

1 message

Aruna Jha =aruna jha@srcc.du.ac.in> Wed, Jun 24, 2020 at 919 PM
To: Coordinator Gho <coordinator.gbo@srcc.du.ac.in>

Forwarded message
From' Reena < enachadhaz6@agmail.coms>

Date: Wed, Jun 24, 2020 at4:21 PM

Subject: Re 7 Day Module as desired *
To: Aruna Jha <ariina jha@srcc.du.ac.in>

Dear Manjir

Apropos aur Conversation regarding time of the 7 day Virtual workshop to be conducted by you, it is suggested that it shall be scheduled from 11 amto 12 noon , everyday
fram 20 th July 2020 through 26 th July 2020. Please ask your office to raise the bill in the name of SRCC GRO and also share the details of your bank account for transfer of
the honorarium | as discussed earlier. '

Locking forward to a fruitful interaction .
Warm Regards
Reena Chadha

Sent from my iPhone
On 23-Jun-2020, at 10:38 AM, Reena <ion) dchadhazé@gmail . oms> wrote:

| think we should, Already spoken to her

Sent from my iPhone

On 22-Jun-2020, at 10:38 PM, Aruna Jha =aruna jha@srce.du.ac.in> wrofe:

Should | forward this to Madam for approval?

On Mon, Jun 22, 2020 at 7:45 PM Reena <reenachadhaZ6@gmail.com> wrote:

% f,nc:q:._m_Staq_.xuwaucuAwn_am.smiun&.mmmﬂnjum___w_cmﬁaﬂ:“.nuz:mm?mmuh4mﬂammmo._mmmmmmnoKm.ms,ﬁ_uamu.@nmb._muowmmg 5533994014 12
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